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Getting Started

Installing HYP2003 Token Driver in Linux Ubuntu

1. Open the terminal and execute the command uname -m to determine if your
system is 32-bit or 64-bit.

2. Extract the downloaded files, then find and open the config folder.
3. Right-click and select the open terminal here or open that path in terminal.

4. Enter the following command:
sudo sh config.sh
5. Enter the sudo user password.

6. After entering the password, you will receive the message Run Finish >

7. Enter the following command:

cd ../redist >

8. Enter the following command:

sudo chmod a+x pkimanager >

9. Enter the following command:

sudo chmod 775 >

10. Enter the following commands:

sudo cp libcastle v2.s0.1.0.0 /usr/lib/ >
sudo chmod 700 /usr/lib/libcastle v2.s0.1.0.0 >
sudo chown user:group /usr/lib/libcastle v2.s50.1.0.0 >

11.Plug the token into the system and double-click to open the pkimanager from redist
folder.

12. Check the status of the token to make sure you receive the message that the token
is inserted and ready to use.
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NOTE: This works for only CSP 2.0 tokens (as per CCA Guidelines for PKI Hardware, issued
in 2018). libcastle v2.s0.1.0.0 is the PKCS#11 library file which communicates with the
token for the certificate.

In the application where you want to use the certificate, that application must be able to
browse PKCS#11 lib (libcastle_v2.50.1.0.0) in it.

If you are using a token with CSP V.10, you can update your existing token to CSP V2.0
from https://update.epasstokens.com.

Setting Up Chrome to Use the HYP2003 Token for PDF
Signing

Chrome for Linux manages digital certificates similarly to Firefox by using Mozilla NSS as the
backend. However, unlike Firefox, Chrome does not provide a graphical user interface to
install PKCS#11 modules. Therefore, to set up Chrome you will need to use the command
line.

NOTE: Make sure your token contains the user certificate and is plugged in before
proceeding. You must also be using a HYP2003 token with CSP V2.0.

1. Open the terminal and install Mozilla NSS Tools if it is not already installed on your
system:

$ sudo apt-get install libnss3-tools

$ sudo mkdir ~/.pki/nssdb

$ sudo chmod -R 0700 SHOME/.pki

$ sudo modutil -dbdir ~/.pki/nssdb/ -add "ePass2003" -libfile
/usr/lib/libcastle v2.s50.1.0.0

2. modutil will alert you that you need to close your browser if it is not already
closed. Type g <enter> to abort or <enter> to continue.

3. Once any running browsers are closed, press Enter. When the command finishes,
you can reopen your browser.

WARNING: Performing this operation while the browser is running could corrupt your
security databases.

4. Module “epass2003” is added to the database.

Verify that the token has been successfully added by running the following
command:

$ modutil -dbdir sqgl:.pki/nssdb/ - list
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6. As root, to load the root CA (CCA India 2022, 2014) certificate into the NSS
database, enter the following command:

certutil -A -n rootca -i /location of ca root cert/rootcert.pem -t
"CT,CT,CT" -d ~/.pki/nssdb

7. To root load each sub CA'’s public certificate into the NSS database, enter the
following command:

certutil -A -n subca -i /location of subca root cert/rootcert.pem -t
"CT,CT,CT" -d ~/.pki/nssdb

8. To verify that the certificates have loaded, as root, enter the following command:

certutil -L -d ~/.pki/nssdb

It is also possible to verify the trust of a root CA certificate through the Chrome browser.

1. Open Chrome, then open the menu and click Settings.

@ Root Certificate | CCA Pl New Tab x  + o - g X

Settings

& > C A Notsecure | ccagovin/root_certificate.html % O » 2
Q A* A~ A &= Skip to main col New tab
New window
Controller of Certifying Authorities New incognito window  Ctrl+Shift+N
@ Ministry of Eletronics & Information Technology Home AboutCCA Services FAQ Conta History ;
Government of India
Downloads Ctrl+J
Bookmarks 4
PKI Framework Root CA of India Licensed CAs Root Certificate CA Certificates eSig Zoom - 100% + HH
Print... P
Home » Root Certificate Cast...
Find... C
Root Certifying Authority of ST F 4 > More tools »
22 -
India Z L Root CA of 'g Edit Cut Copy Paste
Certificate Practice Statement A / India Settings
Root Certificate Help '
Expired Root Certificate A root certificate is a self-signed certificate. A root certificate, the top-most certificat: EXIE 3
standard. All certificates below the root certificate inherit the trustworthiness of the root certificate.
Existing Root Certificates
[Name ___________________|valldFrom _____|valid To_______|Certificate ____JlatestCrl
CCA India 2015 SPL 29.01.2015 29.01.2025 (2x8) LK)
CCA India 2014 05.03.2014 05.03.2024 (2xB) (CKB)

NOTE: For Out-of-band Verification of certificates and receiving latest CRLs, send email to verifyroot AT cca.gov.in

2. Select Privacy and Security, then select Security.
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@ Google Chrome ¥ Aug6 18:29

£ Settings Root Certificate | CCA X | New Tab

& C & Chrome | chrome://settings/privacy “ O 8 2

Settings Q, Search settings

You and Google

Privacy and security

Auto-fill

—  Clear browsing data N
Safety check u Clear history, cookies, cache and more
Privacy and security Cookies and other site data

Third-party cookies are blocked in Incognito mode
Appearance

Security
Qo

Search engine
9 Safe Browsing (protection from dangerous sites) and other security settings

Default browser

g ° %« § @ @

Site settings
Controls what information sites can us

1
it

and show (location, camera, pop-ups and more)

()  Onstart-up
Advanced -
Appearance
Extensions 2 Theme
e #A Use Classic
GTK+

About Chrome

Show Home button
Disabled

Show bookmarks bar

3. Navigate to Manage Certificates and click on the Authorities tab.

@ Google Chrome ¥ Aug6 18:30

£ Settings —Security Root Certificate | CCA X | NewTab

& C ® chrome | chrome://settings/security

Settings Q, Search settings

Help improve security on the web for everyone

You and Google Sends URLs of some pages that you visit, limited system information and some page content to

Google, to help discover n eats and protect everyone on the web

Auto-fill

Warn you if passwords are exposed in a data breach

Safety check v —
Y Chrome periodically checks your passwords against lists that have been published online.

When doing this, your passwords and usernames are encrypted, so they can't be read by

Privacy and securit) )
¥ Y anyone, including Google. When you sign in to your Google account, this feature is turned on

Appearance
No protection (not recommended)
e: t protect you against dange! websites, downloads and exten: ou'll sti Safe
Search engine Q  Does not protect you against dangerous websites, downloads and extensions. You'll still get
Browsing protection, where available, in other Google services, like Gmail and Search

A °» % § @ @

Default browser

()  Onstart-up Advanced
Advanced = Manage security keys
»
Reset security keys and create PINs
Extensions (4] Manage certificates

Manage HTTPS/SSL certificates and settings
About Chrome

Google Advanced Protection programme %
Safeguards the personal Google Accounts of anyone at risk of targeted attacks

4. Navigate to org-India PKI and expand the section to find the CCA India 2014,
which is the root-certifying authority in India. Root certificates available on the
HYP2003 token will appear in the list here.
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@ Settings -Manage certif F ertificate | CCA
C @ cChrome | chrome://settings/certificates?search=orgdndia+PK|

Settings
R X You and Gongle

argdenTrust v
B Autofil

org-india PKI -
@  safetycheck
@  Privacy and security CCA India 2014 Vigw

Edit
@  Appearance arg-internet Securlty Resaarch Group
Export

Q  Searchengine

QrgZENPE S A Delete
BN Default browser

org-Japan Certification Services, Inc v
()  Onstartup

orgKrajowa Izba Rozliczeniowa S A v
Advanced -

org-LuxTrust S A v
Extensians &

org-Microsec Ltd v
About Chrome

org-NetLock Kft. v

org-Network Solutions LL.C. -

NOTE: If you can't find the CCA India 2014, you will need to import manually.

5. Click Edit, then check all available checkboxes and click OK.

9 Google Chrome ¥ Aug 6 18:03

Linux Cert Management X S) Skype £ Settings —Manage certifi. X Root Certificate | CCA

& > C ® chrome | chrome://settings/certificates % © ® 2

Certificate authority

The certificate 'CCA India 2014’ represents a Certification Authority
Trust settings

Trust this certificate for identifying websites

Trust this certificate for identifying email users

Trust this certificate for identifying software makers

Gancel “
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Setting Up LibreOffice to Use Chromium Certificates

Chromium users do not need to install and set up Firefox to sign documents with
LibreOffice. Instead, they can set up LibreOffice to use the Chromium public key

infrastructure.

To do so:

Linux and LibreOffice User Guide for HYP2003

1. Open the Tools menu, then click Options.

2. Click LibreOffice to expand the tree on the left side panel, then select Security
and click Certificate.

Options - LibreOffice - Security

¥ LibreOffice
User Data
General
View
Print
Paths
Fonts
/3
Personalization
Application Colors
Accessibility
Advanced
OpenCL
Load/Save
Language Settings
LibreOffice Writer
LibreOffice Writer/Web
LibreOffice Base
Charts
Internet

v Vv V.V Vv Vv Vv

Help

Security Options and Warnings

Adjust security related options and define warnings for hidden
information in documents.

Passwords for Web Connections

[_] persistently save passwords for web connections

¥ Protected by a master password (recommended)
Passwords are protected by a master password. You will be
asked to enter it once per session, if LibreOffice retrieves a
password from the protected password list.
Macro Security
Adjust the security level for executing macros and specify
trusted macro developers.
Certificate Path
Select the Network Security Services certificate directory to use

Options...

Connections...

Master Password...

Macro Security...

3. In the Certificate Path window, click Add.

Hypersecu Information Systems Inc

Certificate...
for digital signatures. h
TSAs
Maintain a list of Time Stamping Authority (TSA) URLs to be TSAS
used for digital signatures in PDF export.
Reset Apply Cancel OK
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FEiDIdLwEn llly dave de)WUl Uus 101 WEU LUNTHELLIVID

- Cor
y | [sd Dentactad bue arnacta At Ay i
zatior Certificate Path o x|
nes Maste
lity Certificate Path L
l Select or add the correct Network Security Services Certificate directory to use for
digital signatures: |
itting 7 Profile Directory Maci
Nriter
Nriter|
jase T
Ce
e
-
Help Add... || Cancel OK
[
NOTE: Chromium stores its certificate configuration in ~/.pki/nssdb/
4. In the Select Path field, press Ctrl+L to manually enter the location.
5. Enter ~/.pki/nssdb/ and click OK.
( Select Path ]
Cancel Enter location or URL _Q ‘ =i [}
©® Recent ~/.pki/nssdb/1
T bin 11 Mar 2019
[ Desktop B
| Desktop 21:21
[ Documents ] Documents 22:15
& Downloads .| Downloads 21:25
73 Music 21:21
Callalit =] Pictures 22:20
[ Pictures | Public 21:21
. ] Templates 21:21
@ Videos == .,
< Videos 21:21
inj Trash

6. Click OK in the Certificate Path window to close the window, then click OK in the

Options window to close the window.
7. Restart LibreOffice to complete setup.
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Setting up Mozilla Firefox to Use the HYP2003 Token to
Sign PDFs in LibreOffice

NOTE: Before getting started, be sure Mozilla Firefox can browse PKCS#11 lib
(libcastle_v2.s0.1.0.0) in it.

1. Open Firefox, then enter about :preferences#privacy into the address bar and
press Enter.

2. Click Security Devices to open the Device Manager.

Activities ©) Firefoxweb Browser v

C @ Firefox  about:preferences#privacy o @ =

e
@3 General
Warn you about unwanted and uncommon software
5 (@ Home
oy
Q search Certificates
q H : : Query OCSP responder servers to confirm the current validity  View Certificates...
Privacy & Security o
of certificates
Security Devices...
> Q Sync

m More from Mozilla
HTTPS-Only Mode

% HTTPS provides a secure, encrypted connection between Firefox and the websites you
% visit. Most websites support HTTPS, and if HTTPS-Only Mode is enabled, then Firefox will
upgrade all connections to HTTPS,

Learn more
Enable HTTPS-Only Mode in all windows
Enable HTTPS-Only Mode in private windows only
%) Extensions & Themes © Don't enable HTTPS-Only Mode

@ Firefox Support

3. Click Load.
4. In the Module Name field, enter ePass2003.

5. In the Module File Name field, enter /usr/lib/libcastle v2.s0.1.0.0.
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Device Manager X
security Modules and Devices Details Value tan in
~ NSS Internal PKCS #11 Module
Log Out
Generic Crypto Services
Software Security Device Load PKCS#11 Device Driver e e

v Builtin Roots Module Enter the information For the module you want to add. Load
NSS Builtin Objects Module Name | ePass2003 unload
~ OS Client Cert Module
Module filename | fusr/lib/libcastle_v2.s0.1.0.0| Browse...

Cancel OK

6. Click OK to close the Device Manager.

Activities ©) Firefox Web Broy May 16 16:32

3 Settings

< @ Firefox about:preferences#privacy

Device Manager

Security Modules and Devices Details | value Login
v NSS Internal PKCS #11 Module Status Not Logged In
Log Out
Generic Crypto Services Description ESSLOT 1
Software Security Device Manufacturer EnterSafe Change Password

v Builtin Roots Module HW Version 1.0 Load

NSS Builtin Objects FW Version 1.0

Unload
v ePass2003 Label ePass2003

ES SLOT Manufacturer Feitian Technologies Co., Ltd Enable EIPS
v OS Client Cert Module Serial Number 2315BB5980108034
HW Version 1.0

FW Version 1.0

7. Click Certificate.

8. In the Your Certificates tab, you can view the current user certificate on the
HYP2003 token.

NOTE: Make sure the token is with root chain of CCA and Issuer CA.
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@ Firefox about:preferencesiprivacy

Certificate Manager

Your Certificates Authentication Decisions People Servers Authorities

You have certificates from these organizations that identify you

Certificate Name | security Device | serial Number

v eMudhra Limited

Class 3 Individual Test €Pass2003 01:52:9E:03

Backup All...

9. Click the Authorities tab and find the India PKI. Click Edit Trust, then check both
checkboxes and click OK.

k)
The certificate “CCA India 2022" represents a Certificate Authority.
Edit trust settings:
This certificate can identify websites
s & This certificate can identify mail users,
Cancel oK
.
S —_—— o =~ e ]|
[ISRG Root X2 Builtin Object Token

10. Open the LibreOffice writer and go to Tools > Options > Security > Certificate

11.Make sure Firefox:default-release is selected, then click OK.

Hypersecu Information Systems Inc 10 HSTE-NB0065-IND-RV 1.0
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User Data
General
View
Print
Paths

Personalization
Application Colors
Accessibility
Advanced
OpencCL

» Load/Save

' Language Settings

» LibreOffice Writer

» LibreOffice Writer/we

» LibreOffice Base

» Charts

»Internet
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Security Options and Warnings

by rel ione

Passwords for Web Connections

Persistently save passwords

Certificate Path

Certificate Path

Select or add the correct Network Security Services Certificate directory to use For
digital signatures:

Profile Directory

Select NSS path... Cancel

11
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Digital Signing with LibreOffice

If you have a digital certificate, you can sign documents before sending them to ensure the
recipient is confident about the documents’ authenticity and integrity. LibreOffice can sign
not only Open Document Format (ODF) documents, but also any PDF documents including
those created by other programs.

Although capable of digitally signing documents, LibreOffice does not have its own public
key infrastructure. Instead, it uses the infrastructure of a web browser to sign documents.

Mozilla Firefox Browser

By default, LibreOffice looks for certificates and cryptographic media in the Mozilla Firefox
configuration. If you use Firefox, you must set it up before signing documents with
LibreOffice. To do so, follow the procedures described in the documents below:

e How to install website certificates on Linux

e Using smart cards on openSUSE Linux

Chromium-Based Browsers

Linux Kamarada 15.1 brings Chromium as default web browser. If you use Chromium (or a
Chromium-based browser, such as Google Chrome, Opera, Vivaldi or Brave), you can set up
LibreOffice to use it instead of Firefox.

To do so, follow the procedures described in the document below:

e Setting up smart card authentication on Google Chrome / Chromium

Digitally Signing ODF Documents

The Open Document Format (ODF) is the default file format for LibreOffice. The following file
types and extensions are all considered ODF documents and can be digitally signed:

e .odt for text documents, opened with Writer

e .ods for spreadsheets, opened with Calc

e .odp for presentations, opened with Impress

e .odg for graphics (diagrams, vector images), opened with Draw
e .odb for databases, opened with Base

e .odf for mathematical equations (formulas), opened with Math

Hypersecu Information Systems Inc 12 HSTE-NB0065-IND-RV 1.0
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This section will use a .odt file to demonstrate how to digitally sign an ODF document.
The steps will be similar for all ODF files using a LibreOffice Suite application.

1. Open the File menu, then navigate to Digital Signatures and click Digital

Signatures.
test.odt - LibreOffice Writer - B X
File Edit View Insert Format Styles Table Form Tools Window Help x
New B R Y0 k%Y B-RlAHs-0- &4 -
Open... Ctri+O0 ! seii IO 45 = B I Q = Az Az Qy A' 0. === .
OpenRemotes: ‘ ——*7,* I =
Recent Documents A “ & B *r( “ 47 ‘ B ‘ < @
Close (a0
Wizards 4 L]
TEOptes ’  digitally signed. A/
() Reload
Versions... @
Save Ctri+S @'
Save As... Shift+Ctrl+S
Save Remote...
Save a Copy... l
save All I
Export...
Export As »
Send 4
Preview in Web Browser
(O Print Preview Shift+Ctri+Q
Print... Ctrl+P
Printer Settings...
Properties...
Digital Signatures 4 Digital Signatures... [\
ExitLibrepfﬁce ) Czi'io‘QA. JSignE?(istin?PDrF...' T m T e T oo

2. If you are prompted to save the document, click Yes.
3. In the Digital Signatures window, click Sign Document.
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Digital Signatures X
The following have signed the document content:
Signed by Digital ID issued by Date Description Signature type
[V Use AdES-compliant signature when there is a choice
[ View Certificate... ‘ l Sign Document... 5 \ Remove 1 [ ‘Start Certificate Manager... J
Help

4. Enter the token’s PIN, then select the certificate you want to use to sign the
document and click Sign.
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Select Certificate x

Select the certificate you want to use for signing:

Issued to Issued by Type  Expiration date Certificate usage

ANTONIO VINICIUS MENEZES MEDEIROS Autoridade Certificadora SERPRO X.509 Digital signature, M

l View Certificate... ‘

Description: ’ ‘

‘- Help \ : Cancel H Sign g

5. In the Digital Signatures window, confirm that the document has been digitally
signed and click Close.

Digital Signatures X

The following have signed the document content:

Signed by Digital ID issued by Date Description Signature type

4. ANTONIO VINICIUS MENEZES MEDEIROS Autoridade Certificadora SERPRO 03/12/2020 22:24:42

@ The signatures in this document are valid

(¥} Use AdES-compliant signature when there is a choice

I View Certificate... ‘ I Sign Document... ‘ ‘ Remove ‘ ‘ Start Certificate Manager... ‘

‘ Help | | Close k!
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View Certificate

This certificate is validated.

Issued to: ANTONIO VINICIUS MENEZES MEDEIROS
Issued by: Autoridade Certificadora SERPRORFBVS
Valid from:

Valid to:

Digitally Signing Existing PDF Documents

LibreOffice also sign any existing PDF documents, including those created by other
applications outside LibreOffice.

To sign an existing PDF document using LibreOffice:

1. Open the File menu, then navigate to Digital Signatures and click Sign Existing
PDF.

2. Open the PDF document you want to sign. LibreOffice will open the document in
Read-Only mode.
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wikipedia.pdf (read-only) - LibreOffice Draw

= %
File Edit View Insert Format Page Shape Tools Window Help X
-5l e - - | @ - - 5% - »
@ThisPDFisopen in read-only mode to allow signing the existing file. Edit Document || Sign Document . X
+
WiktpioiA
PDF

3. Click Sign Document and follow the procedures described in steps 3-5 in Digitally
Signing ODF Documents to complete the digital signing process.

Checking the Digital Signature on ODF Documents and
Existing PDF Documents

When you open a digitally signed ODF document or a digitally signed existing PDF

document, LibreOffice will inform you that the document is signed. It will also display the
Digital Signature icon on the status bar.

[ — —— - — ?
test.odt (Signed) - LibreOffice Writer - o x
File Edit View Insert Format Styles Table Form Tools Window Help X
3 L Al - ‘ =oze RO i V| | om B= . v 4
-5 0= g - Geds 1 EE-E2EdiA ~=E5-Q- & »

Default Style | ~ % &ﬁ Liberation Seri | v | | 12 ~- B I U<%S A2 A A A' 2 i=El=E = -

@ This document is digitally signed and the signature is valid. Show Signatures = X @)

5 R ) i | o3 i T g 6 s 5 I =
| [

A/

This document is going to be digitally signed. =

| °

Page 1 of 1 8 words, 46 characters

Default Style

English (USA) I. = [e D DO M ® + | 100%

Digital Signature: The document signature is OK.

To view the document’s digital signature:
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1. Double-clickthe Digital Signature icon on the status bar or click Show
Signatures on the system message.

2. In the Digital Signatures window, select a digital signature and click View
Certificate to view more details.

NOTE: The Certificate Information “This certificate is validated” and the Certification status
“This certificate is OK” indicates that LibreOffice has established the Certification Path up to

the certificate of a known certificate authority.
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